# THIS WEEK’S HIGHLIGHTS #





Emperor v1.07 patch was released, tips and tricks from some of the guys from Westwood and Intelligent Games, and some more Emperor reviews.





# EMPEROR v1.07 PATCH RELEASED #





A patch for v1.07 of Emperor has been released. The patch fixes/adds the following:





“GENERAL ISSUES


1. Upon leaving a single-player campaign, a prompt now appears to confirm you wish to leave the campaign.


2. Fixed a bug where LAN game setup screen could be changed without other players agreeing to it.


3. Pressing a group key # twice will center the screen on that group (same as Alt+Group#).


4. You can ‘Attack Move’ by using Ctrl+Shift when selecting a movement destination. This will cause units to move to that location, and stop to engage units along the way. If there are any of your units at the end of the encounter, they will continue on to their final destination.


5. You can now right-click your cursor on the radar map in upper right-hand corner, and the camera will move to that part of the game map. This will not deselect currently selected units.


6. Subtitles will appear again on the movies (a bug in v1.06 had disabled them).





MULTIPLAYER AND WOL ISSUES


1. You may now whisper to another player in the chat lobby by clicking on their name to highlight it and type a message in the normal text box. That message and all messages made while the player is selected will only appear in their chat window. Use right-click on their name to deselect them and do normal broadcast chatting.


2. You may now choose your House & Sub-House preference for Quickmatch (Ladder Ranked) games. Go to Options->Multiplayer Info and choose ‘More’. You will need to re-select your preferences (if you had already done this before v1.07 patch) in order for them to be passed to the Quickmatch system.


3. The Westwood OnLine (WOL) Custom lobby will now refresh open games when you return from the chat area.


4. WOL lobbies now update pings more frequently, and defaults to a ‘?’ instead of 1000.”





The patch can be applied via Emperor’s autoupdate feature, or by downloading the file from Westwood’s FTP server.





Emperor v1.07, English version -


ftp://ftp.westwood.com/pub/emperor/update/EM107EN.EXE





Emperor v1.07, German version -


ftp://ftp.westwood.com/pub/emperor/update/EM107DE.EXE





Emperor v1.07, French version -


ftp://ftp.westwood.com/pub/emperor/update/EM107FR.EXE





Emperor v1.07, Korean version -


ftp://ftp.westwood.com/pub/emperor/update/EM107KO.EXE





Emperor v1.07, Chinese version -


ftp://ftp.westwood.com/pub/emperor/update/EM107CH.EXE





On the FTP site, there is an install fix zip file. Cliff Hicks (Devinoch) replied to Gob saying that the install fix is a very early beta, and they have not fully tested it yet. So I guess it’s “download at your own risk”.





Emperor install fix -


ftp://ftp.westwood.com/pub/emperor/update/EMPINSTFIX10.ZIP





# EMPEROR TIPS AND TRICKS #





Throughout this week, Westwood posted various strategies from the Emperor producer, Intelligent Games (co-developer), the QA team, and Emperor community Manager:





Tips from Emperor Producer, Chris Longpre -





“. I like to place Atreides Snipers, Harkonnen Flamer Throwers or Ordos Chemical Troopers at the base of my ramps to eliminate enemy scouts. Be sure to cover you ramps evenly and don't leave any gaps. The enemy can't attack you if he doesn't know where you are.


2. Ordos Laser Tanks make great hit and run units. Build at least five, then group them. Now you can slide in fast and take out a turret or an armored unit before retreating. However, make sure to retreat the moment one of your laser tanks is about to lose its shields. Take them to the desert to regenerate their armor and shields. Also, Atreides Minotaurs and Harkonnen Assault Tanks die quickly if you drive laser tanks in circles around them. The Laser Tank turrets will take them out without taking any damage of their own.





3. Here's an anti-Guild NIAB Tank tactic. I like to leave six or seven Fremen Feydakin Warriors in guard mode in the back of my base next to an open area for the enemy NIABS to pop in at. They can't see the stealth Feydakins until it's too late. As a bonus, it will cost your enemy a ton of credits to rebuild them.





4. The Ordos Eye in the Sky units are deadly, especially when an enemy's power is down (hence no anti-air turrets). Watch out for Atreides Mongoose and other rocket-bearing units though. Fly a small squad of the EITSs into your enemy's base, and when their shadow is in the middle of the building, hit 'D' and watch the damage rain down from above. With three EITSs, any con-yard is dust.”





Tips from Emperor QA Analyst Ben Gallery -





“1. Build five Ordos NIAB tanks and teleport them to a very remote corner of the map, out of your enemy's view. Then send a small force of other units into your enemy's base to distract him (hitting his harvesters will work). When you enemy is busy defending his turf, send in the NIABs and watch everything go BOOM!


2. Here's a nasty engineer tactic. Build an Atreides or Ordos APC, an Advanced Carryall, and five engineers. Load the APC with the engineers, pick it up with the Advanced Carryall, and voila! You have a mobile base capturing squad.





3. Create a Tleilaxu Terror. Line your ramps with Tleilaxu Leaches and Contaminators. Not only will they defend against enemy attacks, but they will increase their numbers with every kill.





4. Using Ixian Projectors, especially with long range units like Harkonnen Missile Tanks or Atreides Minotaurus, can be a cheap, effective way of breaking an enemy's base defenses with little or no harm to your main force. Using the projections will serve as a distraction, pulling an enemy away from their base for your "real" units to move in.





5. Here's a great Harkonnen Buzzsaw defense. Always keep several Buzzsaws at the entrances to your base. Not only will they stop any scouts from coming in, but a single Buzzsaw can take out dozens of infantry with it's massive blade. Kiss that Engineer/Infantry/Fremen rush goodbye!





6. Make it difficult for your opponent to get credits. Place a series of waypoints covering the enemy's spice field and with five to 10 Buzzsaws following the path, and watch the enemy's spice get chopped up into dust.





7. Scouts are essential to spotting stealthed units. Having 20+ scouts on the map, especially at narrow choke points or ramps, will help spotting those problem Fremen, Ixian Infiltrators, APCs, and any other stealthed nasties.





8. Having a large group of Ordos Dust Scouts hidden in a dust bowl is a great sneak attack against the enemy. The key is to wait until a group of enemy units moves past your hidden Dust Scouts, and then hit them from behind.





9. Use infantry rock wherever and whenever possible. Infantry that are in the infantry rock are extremely hard to kill and do a little extra damage to boot. Most maps have some nicely placed infantry rock at key points and, if used correctly, can turn the tide of any battle.”





Tips from Co-developer Intelligent Games -





“* Learn the map layouts for multiplayer matches - familiarity allows you to determine where the enemy bases are. Find your favorite map if you're hosting and use the layout to your advantage. For example, Koth Crater's symmetry is perfect for early engineer attacks and rushes. 


* Adopt a sensible build order after MCV deployment: first a Windtrap, then Barracks, which you should upgrade immediately. After that, build your Refinery, followed by your Factory. 


* Get your Scouts out into the map ASAP - intelligence is key to winning! 


* Build at least one Turret and create an infantry perimeter around your base - These defenses will eliminate Scouts and hinder early rushes. 


* If you're playing a game with pre-built bases, waypoint one harvester/carryall around the map edge - its a quick way of revealing enemy bases early on. 


* In emergencies, use the Harvester to crush enemy infantry - it can take heavy punishment. 


* When harassing enemy Harvesters, go for the Carryall first - this severely weakens the harvester's mobility. 


* Post Engineers beside key buildings - not only can they repair them in emergencies, but can also recapture them when captured by your enemy. 


* Scatter Scouts around the bottom of your ramp and post defensive units at the top - this is crucial to stopping sneaky stealth attacks from Atreides APCs, Fremen and Ixian Infiltrators. 


* Fremen Fedaykin are a perfect surprise base defenses. They are a great way to ambush enemy vehicles dropped into your base via the Advanced Carryall. 


* If you suspect the presence of stealthed intruders in your base, move a building template over the rock. This works like an improvised scanner - enemy stealthed objects will show up a red against the green template. 


* Prior sending an engineer to capture an enemy building, have a turret ready made so that you can place it by the captured building immediately. 


* An alternative way to gain a foothold on an enemy base is to airlift an MCV onto an empty patch and deploy it. However, only does this in combination with another attack. 


* Try to support a base attack with a special weapon. The combination is invariably lethal. 


* If you airdrop a unit into an enemy base, remember to use your Advanced Carryall to pick up a valuable enemy vehicle in the ensuing confusion. Have a formidable reception committee at home base ready for the stolen unit. 


* Always make good use of the 'CTRL + number' system. Its very useful when coordinating Advanced Carryall attacks and groups of Ixian Projectors. 


* During a lull in the game, get anti-infantry units to force fire onto nearby infantry rock. Players will often place stealthed Fremen units on such areas. 


* Try to obtain enemy house tech trees by putting an engineer into an enemy conyard. Then use your enemy's technology in combination with your own.”





More tips from IG (House and Subhouse specific) -





“House Harkonnen: 


* Scatter a group of Rocket troopers in front of your slow vehicles - they're cheap, good against vehicles and will draw enemy fire away from your expensive units. 


* Use Missile Tanks instead of Gun Turrets as base defense - they're cheaper, mobile, and require no base power. 


* Flamer units are not only good against infantry, but are also great for destroying buildings with their continuous fire. 


* Always use Buzzsaws against Leeches. They're immune to leech spores. 


* When using ADPs - make sure you produce lots of them. Clusters of them are surprisingly good against buildings and vehicles. 


* A Death Hand Missile can practically take out a factory in one shot - if possible, aim it so that the residual radiation is in front of an enemy barracks. 


* Combine a Devastator with an Advanced Carryall for a great base-buster!





House Ordos:


* Alternate a series of Dust Scout and Laser Tank hit and run attacks on the enemy. Their combination of high mobility and regeneration is perfect for eroding enemy forces. 


* Always aim the Deviator at slow-moving or stopped vehicles. Then they can't fail. 


* If you see an enemy MCV - Deviate it. Deploy it while under your control and the resulting Con Yard is permanently yours. 


* Use Kobras in groups - their concentrated firepower stops infantry and land vehicles 


* Deviate unguarded enemy Harvesters - and get them to unload their spice in your refineries.





House Atreides:


* Station Repair Vehicles beside valuable elite vehicles. 


* Here's the ultimate base-buster combo: an Advanced Carryall, an APC and five Engineers 


* Use the Mongoose instead of the Rocket Turret as base defense. Again, it's mobile, less expensive, and doesn't use base power. 


* Place Air Drones over enemy spice fields. They're great at killing Carryalls and starving the enemy of spice 


* If your Con Yard gets damaged, undeploy it and use a Repair Vehicle on it for cost-free repair. 


* Don't forget to place elite infantry inside your barracks - this allows you to train veteran troops





Subhouses:


* Guild NIAB Tanks always work best in numbers during base assaults. If possible, drive them into attack and use the teleport to escape - very frustrating to the enemy. 


* Tleilaxu Leeches are best suited for Harvester harassment. Spores on Harvesters prevent Carryalls from picking them up. Also, whenever you Leech a vehicle, try to damage it with additional firepower - this will accelerate the birth of the leech. 


* Deploy a single Fremen Fedaykin with a thumper. You never know when a worm will come in handy. It's also worth remembering that if a badly damaged Fedaykin summons a 'fresh' worm and dismounts it, he'll recoup all his health. 


* Elite Sardaukars are great for one shot kills on Ordos Laser tanks/APCs. 


* Use Ixian Projectors to replicate enemy Ordos Laser Tanks. It's a cost-free, one-shot kill on an enemy Laser Tank. Fremen are also worth projecting because the projections retain their stealth capability. 


* Whenever fighting against projected armies place scouts near them, which will dispel the projection. Use Atreides Snipers or Fremen warriors against the Projector tanks, which will instantly kill the projections. 


* When moving groups of Ixian Infiltrators across sand, make sure they're scattered. They work best when sneakily deployed around enemy buildings and detonated simultaneously (press 'T' then 'D' to achieve).





Tips from Cliff Hicks (Devonich) -





“* You'll be surprised how many people still fall for an APC full of engineers being airlifted in by an advanced carryall. A good addition to this is to have a turret of some kind ready (generally the one that takes longer to build -- Popup for Ordos, Missile for Atreides, Gun for Harkonnen) and the minute you have stolen a building, put the turret down next to it. Taking someone's base this way is a lot of fun. 


* Be sure to keep some infantry and some anti-air near your spice fields, to prevent enemies hunting your carryalls. 


* Speaking of hunting carryalls, place an anti-air unit (the Atreides Air Drones are especially useful) over spice fields to shoot down your opponent's carryalls and slow his production rate. 


* Go for the "Fremen sneak." Use a small force of troops to lure your opponent's forces into an open area and then sneak Fremen Feydakin up behind to catch your opponent in a crossfire. 


* Keep some long-range artillery units (Ordos Kobras, Atreides Minotauruses, Harkonnen Inkvines, Ordos Mortar infantry) on high ground overlooking spice fields with a few scouts next to them. This will keep opponents out of your spice field. 


* To give your enemy some serious cash flow problems, watch for any harvesters of his that aren't guarded by air defense. Then fly an advanced carryall over and pick it up. Once up, cart it back to your base and drop it down by your front door, where your troops can obliterate it. 


* The best place to use the Atreides Hawk Strike is on fast moving units (Ordos Laser Tanks, Harkonnen Gunships, Atreides Ornithopters). Watching someone's entire air army fly off the map is hysterical.


* If you're airdropping a heavy artillery in (Devastator, Kobra, Minotaurus) -- go for the power stations first. Cutting off his power means you can usually airlift in a lot more reinforcements.


* By far the meanest tactic in my arsenal, however, is the harvester steal. Hunt down all of your enemies harvesters but one, and pick up that last one with an Advanced Carryall. Then fly the Advanced Carryall to the most obscure corner of the map -- do not destroy the harvester. As long as you have his harvester in the air, but not destroyed, he won't get a new free one, and his economy is at a dead stop.”





Official Emperor website -


http://www.duneemperor.com





Shiroko has released version 0.3 of his FAQ for Emperor. The additions include corrections and adjustments as well as a unit’s data table. Shiroko’s FAQs can be downloaded from here.





http://www.dune2k.com/faqs/





# EMPEROR REVIEWS #





Here we go…





The Guru of 3D (no score given)-





“…But while it's certainly not a groundbreaking title, the vast majority of RTS genre veterans will enjoy it thoroughly and toss any minor gripes out the window, all of which are quickly forgotten in the hectic breathtaking battlefield.”





http://www.guru3d.com/gamereviews/dune/





Next Level Gaming = 5/6 (No RA2 review, Three Kingdoms - 5/6) 





“Bottom line? Buy the game. Play the game. Talk nice to the game. Be..the game. “





http://www.nlgaming.com/bin/showreview.pl?document=834.html&filter=





FHM = 5/5 (RA 2 - 4/5, Z2 - 4/5)





“Verdict: Will definitely spice up your life.” 





http://www.fhm.com/games/reviews/gamereview.asp?intID=949





Entertainment Depot = 6/10 (RA 2 - 9/10, Cossacks - 8/10)





“…If you don’t have the time to invest in a more complex title, Emperor: Battle for Dune is excellent for some quick play in-between meetings and class times, but it will leave a majority of gamers feeling like they were missing out on something within an experience that could have been much more.”





http://www.entdepot.com/html/rev_pc_empdune.shtml





Gamer’s Pulse = 80/100 (RA 2 - 93/100, Dark Reign 2 87/100)





“Do you dig the Dune story? Do you dig RTS games? If yes then this one is certainly worth a purchase. It’s solid and balanced, visually spectacular, offers a fairly easy though engaging single player campaign and skirmish mode, and is true (perhaps too true) to the common conventions of the genre. In this sense you already know what to expect. For first-time RTS players it’s a good introduction thanks to simplified unit handling and automatic resource gathering. Moronic AI, messy path finding, and some technical issues detract from an otherwise fun experience. But then there is plenty of fun leftover, which in the end is all that matters.”





http://www.gamerspulse.com/reviews_2001/PC/emperor/dune.shtml





Gamezilla = 72/100 (RA 2 - 94/100, Kohan - 87/100)





“The bottom line: The story is ok. The graphics are ok. The interface is ok. The game is ok. However, there is nothing about Emperor: Battle for Dune that will make the average player sit up and go "wow." To paraphrase a friend of mine, it didn't suck, but it didn't knock my socks off either.”





http://www.gamezilla.com/reviews/e/emperorbfd.asp





Action Trip = 89% (RA2 - 85%, Z2 - 71%)





“All in all, Emperor is an extremely fun game setting new standards in 3D technology and good Westwood-like gameplay. They just had to put a label "Westwood Proudly Presents" on this game instead of a Red Alert 2 commercial.”





http://www.actiontrip.com/reviews/emperorbattlefordune.phtml





FRAGtopia (no score given) -





“Eye candy! The graphics, sounds and music are great. The menus are amazing. The background story is deep and rich. The game itself.... Well..... It's a good, strong RTS, but there's really nothing new here. It's certainly not faboooolous, but worth a play if you're an RTS or Frank Herbert fan.”





http://www.fragtopia.com/reviews/emperor/emporer.htm





GamePower = 3/4 (RA2 - 3&1/2 out of 4, Kohan - 3&1/2 out of 4) 





“Emperor has its flaws, but there's a lot to like here for RTS fans…”





Warning - There is a bit of a plot spoiler at the end of this review.





http://www.gamepower.com/games/html/20835main.html





Gamespot Australia = 9.2/10 (Archived reviews not posted yet)





“…This is easily the best Dune game yet, marrying the convenience of a modern interface with the Dune formula we know and love. Genuine progress has been made, not least of which being co-operative play. Sure, great liberties have been taken with the details from the books. You can choose to view that as being sacrilegious or cheeky, it's really up to the individual. There is now much greater scope for different tactics, and the whole package just drips with character. Perhaps it's not the best RTS ever made, but we were too busy enjoying ourselves to notice.”





http://www.zdnet.com.au/gamespot/pcgames/reviews/story/0,2000013604,20234057,00.htm





Game Revolution = B+ (RA 2 - B+, Earth 2150 - C)





“But what really shines in Emperor is what shone in Dune II before it. The universe feels fully fleshed out and not just slapped together for a game. You understand the houses, the units, the motivations, and the raison d' etre. And of course, harvesting finally feels right.”





http://www.game-revolution.com/games/pc/strategy/emperor_dune.htm





What to post your own review of Emperor? You can do so with FED2k’s fan review section.





http://www.dune2k.com/duniverse/emperor/fanreviews/





# EMPEROR MODS #





Malcolm has made some updates to his Emperor MiniMod.





http://www.dune2k.com/cgi-bin/download/dl.pl?/download/emperor/mod/MiniMod---zip





Readme file for Minimod -


http://www.geocities.com/mlbl/minimod-readme.txt





Malcolm’s website -


http://www.geocities.com/mlbl/mods.htm





Scorpio9a has released a new version of DuneEx. Changes are:





* Added: Recent File list, this will show the 4 last opend files in the File menu (on request)


* Added: Toolbar (thanks to RaGe for the idea)


* Added: View->Refresh function, warning when you changed the file and didn't save then the changes are gone.


* Added: Action->Add Directory, this will add a complete directory


* Added: Help->Read Me, to open the read me with in DuneEx


* Added Websites: Dune Fanatic, Dune 3 Online, Emperor Network and Dune 3 World


* Changed Icon, using Emperor: Battle for Dune icon now


* Improved: You can now also edit the RFH/RFD files


* Fixed bug: Official Emperor: Battle for Dune site didn't work (Oops :])


* Fixed bug: File list wouldn't resize, you needed to resize the total window.


* And some small changes





DuneEx v1.02 -


http://www.ra2factory.com/duneex/setup102.exe





DuneEx v1.02 update from previous version -


http://www.ra2factory.com/duneex/upd102.exe





DuneEx info page -


http://www.ra2factory.com/duneex/





Jez has made a mod called Realistic Dune, which makes the following changes:





 


- Factory for all 3 Houses disabled, so vehicles cannot be produced


- Atredies light infantry and Harkonnen light infantry now do the same damage as with the Sardaukar machinegun, but their cost has gone up more than before, and have less health than before. To counter this, the Ordos chemical infantry have their health raised from 575 to 850


- Starport disabled for all 3 houses, so vehicles cannot be ordered





To make game play slightly more fun....


- Pre-order air units enabled 


- The ornithopter, Harkonnen gunship and Eye In The Sky can all be built by each house ( i did this so each house can have more aircraft)


- The ornithopter has slightly stronger health and a slightly higher cost. 


- All of the houses can build ALL of the pre order units once they have an upgraded hanger ( Once again, i did this cause i like using aircraft )


- The Atredies pre order air drone has been modified so it can fire at ground units too (VERY EFFECTIVE against ALL units and structures, to counter this see balance issues below)





Balance features


- Hanger can now be built after Barracks is constructed, so aircraft can still be built (bypasses factory)


- Palace can be built once Hanger is built, so superweapons are still allowed (bypasses Starport)


- Harvesters CAN be built once you have a hanger (will appear in the "vehicles" tab once Hanger is placed)


- As the Atredies air drone is now SO powerful, it's cost has been raised from 800 solaris to 2000, and also has had its health reduced a lot (making it very easy to destroy by AA fire) It also has had its speed reduced.”





Realistic mod -


http://www.dune2k.com/cgi-bin/download/dl.pl?/download/emperor/mod/RealisticDune---zip





^Sniper^ has updated his Infantry Mod, with the following fixes and changes:





“Updates


~~~~~~~


* Forcibly balanced the game with Sardaukar and Fremen with slightly higher building/training costs and slightly longer build time


* Optimised AI's view of Infantry


* Modified Atriedes Sniper and General Scouts (Killing scouts no longer gives you instantly Elite units)


Bug Fixes


~~~~~~~~~


* Random crashes upon crate-gathering”





The Infantry mod removes most vehicles in the game to make Emperor more like the novels.





Infantry Mod -


http://www.dune2k.com/cgi-bin/download/dl.pl?/download/emperor/mod/Infantry---zip





# DUNE GENERATIONS VIDEO #





The official Dune Generations website has posted a new video showing in-game footage, but with no sound. The video is available in four formats (Real, Quicktime, AVI, and DivX) and can be downloaded from here.





http://www.dunegenerations.com/uk/html/video.htm





Official Dune Generations website -


http://www.dunegenerations.com/





# FED2k POLL RESULTS #





The poll on random House selection in Quick Match games has come to an end. The results are mixed but regardless how you felt Westwood will be changing the system with the 1.07 patch and making it so you can choose your own House. The next poll asking which House you feel is strongest, which should have some interesting results.





Do you like the idea of random House selection in QuickMatch?


 37.6% - (146 Votes) - No


 23.9% - (93 Votes) - Yes


 22.6% - (88 Votes) - Don't Play QM Games


 15.2% - (59 Votes) - Unsure


Total Votes: 388 











Davo (Davo@dune2k.com)


- Newsletter Manager


